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Preface 

This guide gives basic information about on using the VERITAS Enterprise Administrator 
(VEA) Series 500 product to configure and run storage applications such as VERITAS 
Volume Manager. 

How This Guide Is Organized 
This guide is organized as follows: 

◆	 Chapter 1, “Introducing the VEA Console” on page 1, provides an introduction to 
VEA components. 

◆ Chapter 2, “Using the VEA” on page 9, explains how to use VEA. 

◆	 Chapter 3, “Accessibility” on page 37, explains the use of keyboard shortcuts and 
dialog boxes. 

◆ “Glossary” on page 43. 
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Conventions 
Conventions 
The following table describes the typographic conventions used in this guide. 

Typeface Usage Examples 

Courier Computer output, file contents, files, 
directories, software elements such as 
command options, function names, and 
parameters 

Read tunables from the 
/etc/vx/tunefstab file. 

See the ls(1) manual page for 
more information. 

Italic New terms, book titles, emphasis, 
variables to be replaced by a name or 
value 

See the User’s Guide for details. 

The variable ncsize determines the 
value of... 

Courier bold User input; the “#” symbol indicates a 
command prompt. 

# mount -F vxfs /h/filesys 

Helvetica Bold Menu choices; anything that the user 
actually selects, presses, or clicks 

Click Create Disk Group 

Helvetica (bold 
and italic) 

Variables to be replaced by a name or value in 
user input 

# mount -F fstype mount_point 

Symbol Usage Examples 

> Indicates a submenu Start>Run>SAN Volume Manager 
Management Console 

Introduces a procedure 

❖ Indicates single-step procedures 

◆ Indicates a list 

Note Emphasizes important information 

% C shell prompt 

$ Bourne/Korn/Bash shell prompt 

# Superuser prompt (all shells) 

\ Continued input on the following line # mount -F vxfs \ 
/h/filesys 

[] In a command synopsis, brackets 
indicate an optional argument 

ls [-a] 

| In a command synopsis, a vertical bar 
separates mutually exclusive arguments 

mount [suid | nosuid] 
x VERITAS Enterprise Administrator (VEA 500 Series) Getting Started 



Getting Help 
Getting Help 

For technical assistance, visit http://support.veritas.com and select phone or email 
support. This site also provides access to resources such as TechNotes, product alerts, 
software downloads, hardware compatibility lists, and the VERITAS customer email 
notification service. Use the Knowledge Base Search feature to access additional product 
information, including current and past releases of product documentation. 

Diagnostic tools are also available to assist in troubleshooting problems associated with 
the product. These tools are available on disc or can be downloaded from the VERITAS 
FTP site. See the README.VRTSspt file in the /support directory for details. 

For license information, software updates and sales contacts, visit 
https://my.veritas.com/productcenter/ContactVeritas.jsp. For information on 
purchasing product documentation, visit http://webstore.veritas.com. 

Documentation Feedback 
Your feedback on product documentation is important to us. Send suggestions for 
improvements and reports on errors or omissions to foundation_docs@veritas.com. 
Include the title and part number of the document (located in the lower left corner of the 
title page), and chapter and section titles of the text on which you are reporting. Our goal 
is to ensure customer satisfaction by providing effective, quality documentation. For 
assistance with topics other than documentation, visit http://support.veritas.com. 
Preface xi 
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Introducing the VEA Console 
1

The VERITAS Enterprise Administrator (VEA) Console displays data about application 
objects and connectivity in graphical form and provides a user interface for the many tools 
and functions. 

Before using the VERITAS Volume Manager VEA GUI, you should familiarize yourself 
with the following introductory topics: 

◆ VEA Features 

◆ Main Window 

VEA Features 
You use the VEA  to administer disks, volumes, and file systems on local or remote 
machines. 

VEA  consists of a server and a client. The server runs on a machine that is running the 
application to be monitored, such as VxVM. The client runs on Windows, HP, Linux, 
Solaris, and AIX machines that support the Java Runtime Environment. 

VEA provides the following features: 

◆ Accessibility - Using the Mouse and Keyboard 

Accelerators and mnemonics are provided as alternatives to using the mouse (refer to 
the VEA online help for more information). 

◆ Ease of Use 

The task-based user interface provides access to tasks through menus or a task list. 
Administrators can easily navigate and configure their systems, and browse through 
all of the objects on the system or view detailed information about a specific object. 

◆ Remote Administration 

Administrators can perform VxVM administration remotely or locally. The VEA client 
runs on UNIX or Windows machines. 

◆ Java-based Interface 
1 



Main Window 
A pure Java-based interface is used. Administrators can run VEA as a Java 
application. 

◆ Scalability 

◆	 VEA can handle systems containing large numbers of disks. Administrators can view 
all of the objects on the system, or focus on a specific object or set of objects. 

◆ Security 

Please refer to the VEA online help for information on communication between the 
client and server across a firewall. 

◆ Multiple VEA Support 

The VEA client can provide simultaneous access to multiple host machines. The 
administrator can use a single client session to connect to multiple hosts, view the 
objects on each host, and perform administrative tasks on each host. Each host 
machine must be running the VEA  server. 

◆ Multiple Views of Objects 

VEA  provides multiple views of objects: 

◆ The main window tree and grid view lists objects on the system. 

Other views are application dependent. For example, when running VxVM: 

◆	 The Disk View window displays a graphical view of volumes, disks, and other 
objects in a disk group. 

◆ The Volume View window displays a graphical view of the volumes on a host. 

◆	 The Volume to Disk Mapping window shows the relationships between volumes 
and their underlying disks. 

Main Window 
The VEA Main Window and Tabular View consists of: 

◆ Object Tree and Grid 

◆ Menu Bar 

◆ Toolbar 

◆ Status Area 
2 VERITAS Enterprise Administrator (VEA 500 Series) Getting Started 



Main Window 
Main Window and Tabular View 

The toolbar can be separated from and reattached to the main window (this is known as 
docking). The grid can be replicated in a separate window. 

Object Tree and Grid 
The VEA main window is divided into two main panes: 

◆ Left Pane (Object Tree) 

◆ Right Pane (Grid) 

Object Tree 

The following object groups typically appear as nodes in the object tree: 

◆ Bridges/Routers 

◆ Fabrics 
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Main Window 
◆ Groups


◆ Hosts – Any host machines connected to the current VEA  client session.


◆ Hubs


◆ Storage, including enclosures and unenclosed storage


◆ Unidentified Adapters


Grid 

The right pane contains a grid, which is a tabular display of objects and their properties. 
The grid displays objects that belong to the group icon that is currently selected in the 
object tree (left pane). 

The splitter is the vertical bar that separates the object tree from the grid. You can resize 
the left and right panes by pressing and holding the mouse button over the splitter and 
dragging the splitter to the left or right. 

Menu Bar 

The menu bar at the top of the main window contains the following menus: 

◆ File 

The File menu establishes new host connections, disconnects current host sessions, 
provides access to an object Properties window, handles page setup, executes print 
and print preview functions, or exits VEA. 

◆ Tools 

The Tools menu allows you to: 

◆ Initiate the setting Preferences dialog 

◆ Manage User Profiles 

◆ Maintain the VEA Error Console 

◆ Actions 

The Actions menu is a context-sensitive menu that launches tasks on a selected object. 
It is inactive until you connect to a host. The Actions menu is dynamic and changes its 
options based on the type of object that is selected. When an object is selected, the 
Actions menu provides access to tasks appropriate for the selected object. 

◆ Window 
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Multiple Selections 
The Window menu gives you access to the Tear off feature. This allows you to copy 
views displayed by the VEA Client into new windows. You can then view details of 
several different object types at the same time, and to correlate relationships between 
them. 

Window -> Tear off 

Then select the view to be displayed in a new window from the drop-down menu. 

◆ Help 

The Help menu provides access to online help for VEA. 

Toolbar 

The toolbar provides quick access for performing some of the program’s most common 
tasks. 

The toolbar handle is the thin bar next to the toolbar. You can use the toolbar handle to 
separate the toolbar from the main window or move the toolbar to the bottom, side, or top 
of the main window. To reposition the toolbar, press and hold the mouse button over the 
toolbar handle and drag the toolbar to its new location. 

Note The toolbar handle is not visible when running on UNIX clients. 

Status Area 

The status area is at the bottom of the main window. When an object fails or experiences 
an error, an alert (error) icon appears in the status area. The Alert Monitor window 
provides details about the error. You can access the Alert Monitor window by 
double-clicking on the alert icon in the status area. 

Multiple Selections 
You can select more than one object from a list (for example, when you need to add several 
disks into a disk group) using the SHIFT and CONTROL keys in conjunction with the left 
mouse button. 

Use the SHIFT key to select a range of objects. 

Use the CONTROL key to select individual objects. 
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Accessing Tasks 
Accessing Tasks 
Most VEA tasks are performed by selecting objects and/or tasks and then completing the 
resulting dialog boxes. With VEA, you can access tasks from the menu bar and from a 
context-sensitive popup menu. 

Viewing Task History 
VEA logs all task requests. You can view the task history (including tasks in progress) 
using the Task History window, or the Command Log file. 

The Task History window displays a history of tasks performed in the current session 
(and any other sessions running on the machine). Each task is listed with properties such 
as task name, task status, and start time. 

To display the Task History window, click on Tasks at the bottom of the main window. 

Task History Window 
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Command Log 
For a selected task, you can use the popup menu options: Abort Task to cancel the task; 
Pause Task to temporarily stop a task, Resume Task to continue the task; and Throttle 
Task to throttle a task. 

Task Throttling 
Task Throttling causes an operation to pause for the allowed amount of time whenever a 
disk I/O is performed, allowing the CPU and disks to perform other tasks. 

Select the popup menu option Throttle Task to change the task priority. You can change 
the priority for a single task, or select Throttle All Tasks to apply the priority to all 
Volume Manager Tasks. Click Ok to complete your selection. 

Clearing Finished Tasks 
Tasks are persistent in the Tasks console. To remove completed tasks from the window, 
select Clear All Finished Tasks from the popup menu. 

Viewing Task Properties 
To view task properties and the low-level commands used to perform a task, select the 
task and choose Properties from the popup menu. 

Command Log 
The command log file (veacmdlog) contains a history of tasks performed in the current 
session and previous sessions. It contains a description of each task, along with properties 
such as the start/finish times and the low-level commands used to perform the task. For 
failed tasks, the command log includes any relevant error messages. The command log 
file resides, and can be viewed, at /var/adm/vx/veacmdlog. 

The following example shows a sample command log file entry: 

Description: Add Log to Volume

Date: Wed April 17 4:36:11 2002

Command: /usr/sbin/vxassist -g datadg addlog data vol

Output: vxvm:vxassist: ERROR: Volume datavol-L01: Volume’s logging

type not supported

Exit Code: 20
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Command Log 
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Using the VEA 
2


The VERITAS Enterprise Administrator (VEA) enables you to access all hosts on your 
network. It also provides task and setup functions that allow you to tailor your VEA 
environment prior to performing storage management procedures on those hosts. 

This chapter introduces you to: 

◆ Setting Up Your System 

◆ Starting VEA 

◆ Viewing Objects and Object Properties 

◆ Performing Tasks 

◆ Running Tasks From the Menu Bar 

◆ Running Tasks From a Popup Menu 

◆ Setting Layout Preferences 

◆ Setting General Preferences 

◆ Using the Control Panel 

◆ Viewing the Event Log 

◆ Viewing the Task Log 

◆ Connecting and Disconnecting a Host 

◆ Viewing Different Products 

◆ Printing Views 

◆ Exiting the VEA Client 

Setting Up Your System 
VEA consists of a server (vxsvc) and a client (vea). You must install and run the VEA 
server on a UNIX machine running VxVM. You can install and run the VEA client on any 
Windows, HP, Linux, Solaris, or AIX machine that supports the Java Runtime 
Environment. 
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Starting VEA 
Before you can use VEA, you need to: 

1. Install VxVM on the machine to be administered. 

2. Install the VEA server and client on the machine to be administered. 

3.	 If users other than root need to access VEA, set up security to specify which users can 
run VEA. 

4.	 If you plan to run the VEA client from a machine other than the machine to be 
administered, install the VEA client on the machine where the client will run. 

5. Start the VEA server on the machine to be administered. 

6. Start the VEA client. 

Refer to the Installation manuals for your products for details on how to install and set up 
your products and VEA. 

Starting VEA 
Only users with appropriate privileges can run VEA. (Refer to the Installation manuals for 
your products for information on security and access permissions.) 

You can use VEA to administer the local machine or a remote machine. The VxVM 
daemon (vxconfigd) and the VEA server (vxsvc) must be running on the machine to be 
administered. Once VEA is installed, the VEA server starts up automatically at system 
startup. 

You can start the VEA console from a Windows or UNIX client. 

From a Windows Client 
From a Windows client, you can start VEA from the Start menu, or from the command 
line. 

Using the Start Menu 

To invoke VEA from the Start menu, click on: 

Start --> Programs --> VERITAS Enterprise Administrator--> VERITAS Enterprise 
Administrator Console. 
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Starting VEA 
Using the Command Line 

To invoke VEA from the command line: 

1. Go to the directory where the VEA client is installed; for example, 

Object Bus\bin. 

2. Start the VEA client by running the batch file vea.bat from this location. 

When starting the VEA client from the command line, the following options are 
available 

-v : Shows the version of client console. 

-c : Specifies the configuration file for advanced settings. 

-host : Specifies the host to connect to. If the username and password for the host is 
already stored, these will be used; otherwise, you will be prompted for your 
username and password. 

From a UNIX Client 
To invoke VEA from the command line: 

1.	 Go to the directory where VEA client is installed; for example, 
/opt/VRTSob/bin 

2. Start the VEA client by running the script vea from this location. 

When starting the VEA client from the command line, the following options are 
available 

-v : Shows the version of client console. 

-c : Specifies the configuration file for advanced settings. 

-host : Specifies the host to connect to. If the username and password for the host is 
already stored, these will be used; otherwise, you will be prompted for your 
username and password. 

Startup Profile 
If you have selected a password protected profile as your startup profile, you are 
prompted to enter the password when VEA starts up. 

Enter your password and click OK to continue, or click Select Profile to bring up the 
Select Profile dialog, which enables you to select an alternative profile. 
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Viewing Objects and Object Properties 
(Clicking Cancel will end the application.) 

Selecting an Alternative Profile 

Select one of the profiles from the list, and enter the password, if necessary. 

Click OK to log in. 

You can also select Tools > Manage Profiles to bring up the Manage Profiles dialog (refer 
to Managing User Profiles). 

If No Profiles Exist 

If no profiles exist when you start VEA, the following message appears: 

No profiles exist on this system. A new default profile has been

created. If you want to create additional profiles, you may create

using the “Tools” -> “Manage Profiles...” menu item


Click OK to continue. 

You can also select Tools > Manage Profiles to bring up the Manage Profiles dialog (refer 
to Managing User Profiles). 

Viewing Objects and Object Properties 
Objects in the system are displayed in the “Main Window and Tabular View.” 

The tree is a hierarchical display of object groups. The Tabular View displays a table of

objects and a limited set of properties. 


In the VEA client, objects typically represent entities in the product domain.

For example, in the case of VERITAS Volume Manager, the object might be a disk. 

You can use the views to browse objects and guide the operation of the client console.

There are three main views:


◆ Navigation View, at the left, which uses the tree structure 

◆ Detailed View, at the right, which used table structure 

◆ Status View, at the bottom 
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Viewing Objects and Object Properties 
The following functions are provided for simplifying viewing objects in the tree and 
Tabular View: 

◆	 To expand or collapse the hierarchy under a particular object group node in the tree: 
Click on the plus sign (+) or minus sign (-) icon next to that node. 

◆	 To display the objects in an object group listed in the object tree: 
Click on the object group. All objects that belong to the selected object group appear in 
Tabular View. 

◆	 To display the objects in an object group listed in Tabular View: 
Double-click on the object group. All objects that belong to the object group appear in 
Tabular View. 

(Double-clicking on an object that does not contain other objects (children) displays 
the Properties window for the object instead of its children.) 

◆	 To sort the objects in Tabular View by a specific property: 
Click on the appropriate property column heading. To reverse the sort order, click on 
the column heading again. 

◆	 To resize a grid column: 
Place the pointer over the line that divides the column headings, then press and hold 
the mouse button to drag the column divider to the desired position. 

◆	 To resize the left pane (tree) and right pane (Tabular View): 
Place the pointer over the vertical splitter, then press and hold the mouse button to 
drag the splitter to the desired position. 

Selecting Objects 
You can select Tabular View objects in most VEA windows using the following 
procedures: 

◆	 To select a single object: 
Click on the object. 

◆	 To select multiple objects: 
Hold down the Control key while selecting the objects. The objects that you select in 
this way do not have to be adjacent. 

◆	 To select a range of adjacent objects: 
Select the first object, then hold down the Shift key while selecting the last object in 
the range. You can also select multiple adjacent objects by pressing and holding the 
mouse button while dragging the pointer over the desired objects. 
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Viewing Objects and Object Properties 
Navigational View 
Navigational view supports object browsing and operations on those objects in a tree 
structure. The following nodes typically appear in this view: 

◆	 System nodes: representing the connected and disconnected computer systems, these 
are distinguished by icons. 

◆ Network nodes: listing the systems that are currently running on the given domain. 

◆ History nodes: listing the most recently connected servers. 

◆ Favorite Hosts nodes: listing hosts that will be connected by default at start up. 

The system objects are arranged in containers called group nodes. Group nodes can contain 
homogenous or heterogeneous types of objects. You can view detailed information about 
these objects in the Details View by selecting the object in the Navigational View. 

Details View 
The Details View gives a tabular representation of the objects in a particular group node, 
or even a single object, depending upon the selection in the Navigational View. 
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Viewing Objects and Object Properties 
Details View 
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Viewing Objects and Object Properties 
Status View 

The Status View occupies the bottom part of the VEA client window. It has a Console 
View and a Task View. 

Console View 

The Console View displays the active events and alerts for the connected hosts. Click on 
Console to display the events that have been received by the client during the user 
session. The events for all hosts over the lifetime of the session is displayed. 

Note Events on the server side are recorded on the server. 

Tasks View 

The Tasks View displays the start time of the task along with the object name for which the 
task was fired. 

Click on Tasks to display task information. Information is displayed in the context of the 
object being browsed. For example, if hosts A and B are connected, then browsing any 
object in host A displays only tasks from host A; similarly, browsing any object in host B 
displays only tasks from host B to be displayed. 

Note You can use the arrows to obtain the previous or next set of events. 

Properties of an Object 
Each property has the following attributes: 

Property Attributes 

Property Type Definition 

Type	 Defines the property value; for example, boolean, integer with 
varied size, and string. 

Flags	 Determines one of the characteristics of the property (for example, 
Hidden or Displayable). 

Name Identification given to the property.


Value Value assigned to property, depending upon the type.
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Performing Tasks 
A property set is a collection of properties. It can contain an array of properties or even 
another property set as its element. A property set with one or more property sets 
contained within it is called a recursive property set. 

VEA uses Tabular View to display the properties of an object. Each object is represented 
by a row in the table and the properties are the column cells in it. 

Tabular View 

Upon double clicking the property in the table, VEA pops up a dialog box to display the 
array and property set. 

Performing Tasks 
Most VEA tasks are performed by selecting objects and/or tasks and then completing the 
resulting dialog boxes. You can run tasks from the following: 

◆ Menu bar 

◆ Context-sensitive popup menu 

Running Tasks From the Menu Bar  
Once you have connected to a host, you can launch tasks from the Actions menu in the 
main window menu bar. The context-sensitive Actions menu launches tasks on a selected 
object. The Actions menu is dynamic and changes its options based on the type of object 
that is selected in the tree or grid. 
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Performing Tasks 
To perform a task on an object with the Actions menu, select the object and choose the 
appropriate task from the Actions menu. If this launches a dialog box or wizard, 
complete the dialog box (or wizard). 

Running Tasks From a Popup Menu  
Once you have connected to a host, you can use a context-sensitive popup menu to launch 
a task on the selected object, as shown in “Context-Sensitive Popup Menu.” A popup 
menu provides access to tasks or options appropriate for the selected object. Popup menus 
are available in the main window and most other windows. 

Context-Sensitive Popup Menu 

❖	 To perform a task on an object with the popup menu, right-click on the object and 
choose the appropriate task in the popup menu. If this launches a dialog box or 
wizard, complete the dialog box (or wizard). 
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Setting Layout Preferences 
Setting Layout Preferences 
To set layout preferences, select Tools > Preferences then select the Appearance tab. The 
Preferences Appearance Window appears. When you have made your changes: 

◆ Press Apply to apply the changes. 

◆ Press Reset to revert back the changes. 

◆ Press OK to apply and close the Preference Appearance Window. 

◆ Press Cancel to discard the changes and close the Preference Appearance Window. 

Preferences Appearance Window 

Customizing the View Area 

Select View under Items. Choose your color setting and click OK. Select your font 
settings. 
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Setting General Preferences 
Customizing the Background and Foreground 

Select Background (or Foreground) under Items. Choose your color settings and click 
OK. The new settings are displayed. 

Customizing the Menu 

Select View under Items. Choose your color setting and click OK. Select your font 
settings. 

Customizing the Selection Color 

Select Appearance then Selection under Items. Choose your color setting and click OK. 

Customizing the System Font 
Select System Font under Items. Choose your font settings. 

Customizing the Toolbar 

Select Toolbar under Items. Set the following preferences for the toolbar: 

Placement Place the docked toolbar at the top, bottom, or (either) 
side of the main window. 

Icons/Icons and text	 Display icons and/or labels on the buttons in the 
toolbar. 

Customizing the Tooltip 

Select Tooltip under Items. Choose your color and click OK. Select your font settings. 

Setting General Preferences 
The General Tab, provided in the Preferences Appearance Window allows plug-in 
components to be retrieved whenever a connection is made to an server. You can 
configure the number of hosts for which the host information is stored. 
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Setting General Preferences 
General Tab 

Deleting Temporary Files on Exit 
You can delete all temporary files when you leave VEA by selecting the checkbox Delete 
temporary files on exit. 

If you want to delete the temporary files immediately, click the button Delete Now. 
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Connecting and Disconnecting a Host 
Adjusting the History Settings 

To adjust the history settings, go to the General Tab and type the number of servers 
(hosts) for which information can be stored in the history file. 

The maximum limit for the number of hosts for which information can be stored is 99. 

Press Apply to apply the changes, Reset to revert back the changes, OK to apply and close 
the Preference Appearance Window, Cancel to discard and close the Preference window. 

Connecting and Disconnecting a Host 
The system host typically has multiple VERITAS products installed on it. To be able to use 
the products, client console needs to connect to the system through an authentication 
channel. 

VEA can access and display multiple host machines simultaneously. 

◆ Connecting to a Host 

◆ Logon Authentication 

◆ Disconnecting from a Host 

◆ Reconnecting Hosts at Startup 

◆ Using History to View Recent Connections 

◆ Adding Favorite Hosts 

◆ Add Host in the Favorites Folder 

◆ Remove a Host from Favorites Folder 

Connecting to a Host 
You can connect to a system host in the following ways: 

◆ Clicking on File --> Connect 

◆ Clicking on the Connect tool bar icon 

◆	 Expanding History node and selecting a host, then right clicking the mouse to open 
up the popup menu showing Connect As 

◆ Expanding History node and double clicking on system node. 
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Connecting and Disconnecting a Host 
Complete the Connection dialog box as follows: 

Hostname: Enter the name of the machine to be administered. (For VxVM, both 
VxVM and the VEA service must be running on this machine.) 

Username: Enter your login name. Only users with appropriate privileges can 
access VEA on the specified machine. (The service is already 
running on the host.) 

Password: Enter your password for the machine to be administered. Select the 
“Remember Password” box to save the password on your computer. 

When you have provided all necessary information in the dialog box, click OK. The new 
host appears in the object tree in the main window. 

After you have started VEA on one host, you can connect to additional hosts from the 
same session. Each host machine must be running the VEA service. 

Notes: 

◆ This task requires a host machine name, user name, and password. 

◆ Only users with appropriate privileges can run VEA. 

◆ Entries for the user name and password must exist in the password file or corresponding 
Network Information Name Service (NIS) table on the machine to be administered. 

Logon Authentication 

There are three authentication mechanisms by which a connection can be established with 
the server where VERITAS products are installed. 

◆	 Silent Logon (Windows platforms only): This happens when the server is local; that is, 
the VEA client and server both are running on the same machine. If the user has 
logged on with administrator privileges, then username and password are not 
required. (The basic connection dialog box is used.) 

◆	 Native Logon : Username and password are required to authenticate the user. (The 
expanded connection dialog box is used.) 

◆	 DCOM authentication (Windows platforms only): If the user has logged in as 
administrator on the domain, then username and password are not required to 
authenticate the user (the basic connection box is expanded after entering the server 
name and clicking OK), and the user is connected to the server. The server needs to be 
started with administrator privileges for this type of authentication. 
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Connecting and Disconnecting a Host 
If the user does not have administrator privileges, then the connection takes place 
using the Native Logon mechanism. 

Disconnecting from a Host  
The Disconnect procedure disconnects a host machine from the current VEA session. 
When a host machine is disconnected, VEA cannot administer that machine until a new 
connection is made. 

1. Right-click the computer icon to be disconnected. 

2. Select Disconnect from the file menu on the menu bar. 

3. A confirmation dialog will appear, click Yes to end the remote connection. 

4. The computer icon disappears from the left tree view. 

If the connection is lost for any other reason, a message appears that indicates the 
connection has been terminated, and the icon for that computer is removed from the left 
tree view. You need to click OK to close the message box. 

To restore access to a disconnected host machine, you must reconnect to the host. 

Reconnecting Hosts at Startup 

By default, hosts in the Favorite Hosts folder are reconnected at startup. 

You can disable the default by disabling the ‘Reconnect at Logon’ option: 

◆ Right click on the host 

◆ Select (uncheck) the Reconnect At Startup check box 

A host in the favorite hosts folder will not be reconnected at startup if the Reconnect At 
Startup checkbox is not set. 

Using History to View Recent Connections 

VEA uses the History folder in the tree view to list the computers that were connected to 
recently. When you connect to a remote computer for the first time, an icon representing 
the remote computer appears in the History folder. 
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Exiting the VEA Client 
Adding Favorite Hosts 

The Favorite Hosts node contains a list of hosts that will be connected to by default at the 
startup of VEA if the username/password is saved for them. If the username /password 
is not saved for a particular host, then this information will be prompted for at the time of 
connection 

Add Host in the Favorites Folder 

Use the following procedure to add a host to the Favorites folder: 

1. Right click on any of the connected host nodes 

2. Choose the menu item Add to Favorites from the popup menu. 

You can also add any node under History node to the Favorites folder by a right clicking 
that node under History. 

1. Under History, right click on the node to be added. 

2. Choose the menu item Add to Favorites. 

Remove a Host from Favorites Folder 

Use the following proedure to remove a host from the Favorite Hosts folder:


◆ Right click on the node to be removed.


◆ Click on the Remove From Favorites menu item. 


Exiting the VEA Client 
To exit the VEA client, choose File > Exit. 

It is also possible to close the client by using the close button available at the top right of 
the window. 

Viewing Different Products 
VEA allows you to simultaneously access several products on different systems, and to 
view each product in the language of the VEA client, if available. 
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Using the Control Panel 
For example, if you connect from a VEA client, displaying French text, to VERITAS 
Volume Manager running on a remote Solaris system also displaying French, you will see 
French text in the VEA client window. If you now connect the same VEA client 
(displaying French text) to SAN Appliance running on a remote Linux system, displaying 
English text then, if the SAN Appliance is available in French, the VEA client displays 
everything in French. If the SAN Appliance is available only in English, then the SAN 
Appliance information will be displayed in English on the VEA client. 

Using the Control Panel 
Use the control panel to view and modify application settings. After connecting to a host, 
the control panel node can be found directly under the host node in the tree or as a child of 
the host node in the detailed view. Selecting the control panel will bring up the control 
panel view in the right hand pane. 

Control Panel 

Viewing the Event Log 
The event log resides on the server, and records event information, such as alerts raised, 
about the server. You can display a snapshot of the log information on the client. 

After connecting to the host (server), you display the event log of the server by selecting 
the “Event Log” node under “Logs” in the tree view. The server can have single or 
multiple event log files, depending upon the policy. If the server has more than one event 
log file, then a drop down box is displayed from which you select the required log file. 

The client gets the latest set of alerts from the log file of the server and displays the event 
information in the Details View. Up to 25 alerts can be displayed in a set. 
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Viewing the Event Log 
Event Log 

Previous and Next Alert Sets 

The Previous and Next set of alerts buttons are situated below the Details View. 

You can display the next set of alerts by clicking the “Next set of Alerts” button. The 
current set of alerts is then replaced with the next set of alerts. If there are no more alerts in 
the event log, the current set continues to be shown. 

You can display the previous set of alerts by clicking the “Previous set of Alerts” button. 
The current set of alerts is then replaced with the previous set of alerts. When the first set 
is reached, and there are no more old alerts, the “Previous set of Alerts” button is disabled. 

Viewing Alert Details 

You can view the details for particular alert by selecting the alert and clicking on 
“Details.” A new window opens up to show the alert details. 
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Configuring the Event Log 
Alert Details 

Event Log Settings 

The settings for the Event Log are accessed by double-clicking on the Event Log Settings 
icon in the Control Panel view. 

Configuring the Event Log 
You can configure the server event log from the client: 
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Configuring the Event Log 
1.	 Select the “control panel” node in the tree view. The details view appears, listing all 
the configuration applications. 

2. Launch the “Event Log Settings” configuration application by double clicking on it. 

Event Log Settings 

Note	 Whenever you change the event log policy, the old files are deleted and a new event 
log file is created. So it is advisable to take a backup or save the old log file, before 
changing the policy. 

Setting the Maximum Log Size 

You can set the maximum log size from 10 KB to 2 MB. The default log size is 500 KB. 

Using a Single Log File 

Select “Overwrite the log file” to define a single log file. When the log file reaches its 
maximum size, the file is then overwritten, starting at the oldest alert. 
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Viewing the Task Log 
Overwriting After a Number of files 

Select “Overwrite the log file(s) after” to define the number of files after which the oldest 
file is overwritten. When a log file reaches its maximum size, a new file is created until the 
specified number of files is reached. You can specify from one to ten files (default is 5 
files). 

Overwriting After a Number of Days 

Select “Overwrite the log file(s) older than” to define the number of days after which the 
oldest file is overwritten. When the log file reaches its maximum size, a new file is created 
until the specified number of days is reached. You can specify from one to 100 days 
(default is 60 days). The number of days is counted from the day when the first alert log 
file gets created. 

Viewing the Task Log  
The task log resides on the server, and is similar to the event log; but records information 
about task objects. You can display a snapshot of the task log information on the client. 

After connecting to the host (server), you display the task log of the server by selecting the 
“TaskLog” node under “Logs” in the tree view. The server can have single or multiple task 
log files, depending upon the policy. If the server has more than one task log file, then a 
drop down box is displayed from which you select the required log file. 

The client gets the latest set of tasks from the log file of the server and displays the 
information in the Details View. Up to 25 tasks can be displayed in a set. 

Previous and Next Task Sets 

The Previous and Next set of tasks buttons are situated below the Details View. 

You can display the next set of tasks by clicking the “Next set of Tasks” button. The 
current set of tasks is then replaced with the next set of tasks. If there are no more tasks in 
the task log, the current set continues to be shown. 

You can display the previous set of tasks by clicking the “Previous set of Tasks” button. 
The current set of tasks is then replaced with the previous set of tasks. When the first set is 
reached, and there are no more old tasks, the “Previous set of Tasks” button is disabled. 
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Configuring the Task Log 
Task Details 

You can view the details for particular task. Select the task and click on “Details.” A new 
window opens up to show the task details. 

Task Log Settings 

The settings for the Task Log are accessed by double-clicking on the Task Log icon in the 
Control Panel view. 

Configuring the Task Log 
You can configure the server task log from the client: 

1.	 Select the “control panel” node in the tree view. The details view appears, listing all 
the configuration applications. 

2. Launch the “Task Log” configuration application by double clicking on it. 

Note	 Whenever you change the task log policy, the old files are deleted and a new task 
log file is created. So it is advisable to take a backup or save the old log file, before 
changing the policy. 

Setting the Maximum Log Size 

You can set the maximum log size from 10 KB to 2 MB. The default log size is 500 KB. 

Using a Single Log File 

Select “Overwrite the log file” to define a single log file. When the log file reaches its 
maximum size, the file is then overwritten, starting at the oldest alert. 

Overwriting After a Number of files 

Select “Overwrite the log file(s) after” to define the number of files after which the oldest 
file is overwritten. When a log file reaches its maximum size, a new file is created until the 
specified number of files is reached. You can specify from one to ten files (default is 5 
files). 
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Printing Views 
Printing Views 
You can print some of the Views in the right pane by clicking File-->Print. 

Print functionality is determined by the server, which means that the Print and Page 
Setup functions appear only when the VEA installed on the server supports printing. This 
also means that Page Setup may be shown as disabled, even when the Print function is 
available. 

The complete View is printed, including any information which may be scrolled off the 
screen. If there is more than one tab for the displayed View, then only information relevant 
to the displayed tab is printed. 

Managing User Profiles 
The user profile feature enables individual users running VEA on the same machine to 
maintain their own preferences, connection history and favorites information. 

To use the user profile feature, select Tools > Manage Profiles. The Manage Profiles dialog 
appears. This allows you to: 

◆ Set a profile to be used when starting VEA (Selecting a Startup Profile) 

◆ Create a new profile (Creating a New Profile) 

◆ Change your password (Changing Your Password) 

◆ Delete a profile (Deleting a Profile) 
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Managing User Profiles 
User Profiles 

Selecting a Startup Profile 

A default startup profile (Default) is created by VEA when it is invoked by the first time. 
The Default profile is particularly useful when VEA is being used in a single user 
environment, in which case, you can use the Default profile rather than creating 
additional profiles. 

You cannot delete or modify the Default profile, and it is not password protected. 

You also have the option of selecting your own startup profile (in Startup using:). 
Alternatively, you can choose to be asked at each logon, which profile to use. 

Creating a New Profile 

Select the New button to create a new profile. This brings up the New Profile dialog. 

You then enter the desired name for the profile. The following characters are not allowed 
in the profile name: 

“ ~!@#$%^&*()=+-[]{}\\|’\”;:.,<>/?`” 

You can also choose to employ a password. 
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Managing User Profiles 
Note	 You must remember this password, for there is no way of retrieving a lost 
password, and the profile cannot then be deleted at a later stage. (A blank password 
or a password consisting of spaces alone will not be considered for a password, and 
the profile will be marked as not having a password.) 

Changing Your Password 

Select the profile, and then click Edit to change the password for the profile. This brings 
up the Edit Profile dialog. 

You will need to know the current password in order to change your password. 

Deleting a Profile 

Select the profile, and then click Delete to delete a profile. You are then prompted to 
confirm the deletion of the profile. 

If the selected profile is password protected, you are then prompted to enter the 
password. 
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Firewall Support 
Firewall Support 
In VEA, the client connects to the server using a specific port number: 2148. In order to 
connect to the server through a firewall, a port on the firewall is mapped to the 2148 port 
of the VEA server. 

When the client wishes to connect to the server through the firewall, it needs to specify the 
host and port in the following format. 

Firewallhost:port 

where: 

Firewallhost is the name or IP address of the firewall. 

port is the port on the firewall that is internally mapped to the VEA server. 

When the client connects to the server, the VEA client displays the host name (server 
name) that it connected to, and not the firewall-port combination in the list of connected 
hosts. The host name is also displayed in the history and favorites nodes. The firewall and 
port information is stored in the user profile (wallet) and is used for subsequent 
connections to the same server. The firewall-port combination is displayed only in the 
connection dialog. 

Example 1 

If a.b.c.d is a firewall machine, then 

Port 1234 on a.b.c.d = 2148 on veaserver1 and 

Port 3456 on a.b.c.d = 2148 on veaserver2 

... and so on 

Now, if the client wishes to connect to veaserver1 then, it should specify the following in 
the connection box: 

a.b.c.d:1234. 

This then connects to veaserver1 and displays veaserver1 in the connected hosts, history 
and favorites databases. The firewall:port combination is stored in the wallet for 
subsequent connection to the server if requested by the user. 

Example 2 

client ---> internet ----> firewall ----> server


and


client ----> firewall ----> server
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Firewall Support 
We need to do the following: 

1.	 Allow for an alias of port 2148 on server A to be a particular port on the firewall 
machine. 

2. Let Pf be the port on the firewall machine F which is an alias for port 2148 on server A. 

3. Connect using the GUI to port Pf on F. You are actually managing server A 

Note	 VEA uses Anonymous Deffie Hellman key exchange and is therefore vulnerable to 
the man-in-the-middle attack. Therefore it is recommended that SSH or some kind 
of tunneling software be used if going across the internet. If SSH is used set up port 
forwarding from client to firewall port Pf and use SSH to tunnel. 

Example 3 

For the case where 2148 is forwarded through the firewall (punch through): 

1. Let machines A and B be the servers on the secure side of the firewall. 

2. Let client be on the internet/intranet side 

client -----> firewall ----> A|B 

3.	 Configure TCP/IP routing on the client such that packets destined for A|B are routed 
to firewall F. 

4. Add A and B to /etc/hosts (or equivalent) for name resolution if required. 

5. Connect to A and/or B (depending which one to manage) 
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Accessibility 
3


Accessibility is enhanced by the use of: 

◆ Keyboard Shortcuts 

◆ Dialog Boxes 

Keyboard Shortcuts 
Keyboard shortcuts are possible using accelerators and mnemonics. 

Accelerators 

Accelerators are key combinations that provide shortcut access to GUI functions. They 
allow you to use a computer from the keyboard, rather than using the mouse. 
Accelerators are sometimes a quicker way of getting to a command, especially for the 
experienced user or a user who is disabled and is unable to manipulate a mouse or to 
press more than one key at the same time. Accelerator keys are either a single keystroke or 
two or more keystrokes that can be pressed in succession (rather than holding them 
simultaneously). Some users are unable to use a mouse, and some users prefer to use the 
keyboard rather than a mouse. 

Mnemonics 

Mnemonics are single key strokes, used to activate components such as menu items. A 
single mnemonic is equivalent to a mouse click. A mnemonic can be used to select a menu 
item by pressing the <Alt> key to go into menu pull-down mode, pressing a single key to 
open a menu and another key to select a menu item. For example: 

◆ <Alt> to go into menu pull-down mode 

◆ <f> key to access the File menu 

◆ <o> to activate the “open” command 
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Keyboard Shortcuts 
Mnemonics are case insensitive. Keys can be pressed sequentially instead of 
simultaneously. 

Keyboard Mapping Conventions 

Exceptions and additions to the Microsoft Keyboard Conventions are listed in:


◆ VEA Exceptions to Microsoft Keyboard Conventions


◆ VEA Additions to Microsoft Keyboard Conventions


◆ VEA Help Additions to Microsoft Keyboard Conventions


VEA Exceptions to Microsoft Keyboard Conventions 

The table, “VEA Exceptions to Microsoft Keyboard Conventions,” summarizes the 
keyboard differences between the VERITAS implementation of mnemonics and 
accelerators, and the Microsoft keyboard convention: 

VEA Exceptions to Microsoft Keyboard Conventions 

Convention Mnemonic Accelerator 

Cancel C Alt C, Escape 

OK O Alt  O 

Refresh E None 

Yes None None 

No None Escape 

Shift+F10 A Alt A 
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Keyboard Shortcuts 
VEA Additions to Microsoft Keyboard Conventions 

The table, “VEA Additions to Microsoft Keyboard Conventions,” summarizes the 
keyboard additions to the Microsoft keyboard conventions in the VERITAS 
implementation of mnemonics and accelerators: 

VEA Additions to Microsoft Keyboard Conventions 

Convention Mnemonic Accelerator 

Actions A Alt A. Use this accelerator in place 
of Shift+F10 with a selected item to 
bring up the context menu with the 
Actions menu. 

Add category A None 

Add D Alt D 

Connect C None 

Contents C None 

Delete Now None None 

Delete Temporary 
files on Exit 

E Alt E 

Disconnect D None 

Number of items in 
history 

N Alt N 

Password P Alt P 

Previous P Alt P 

Overwrite the log 
file 

W Alt W 

Overwrite the log 
file (s) after 

A Alt A 

Overwrite the log 
file (s) older than 

O Alt O 

Remove E Alt E 

Rescan S None 

Reset R Alt R 

Set to Defaults S AltS 

Remember 
Password 

R Alt R 

Username U Alt U 
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Dialog Boxes 
VEA Help Additions to Microsoft Keyboard Conventions 

The table, “VEA/Applications Help Additions to Microsoft Keyboard Conventions,” 
summarizes the keyboard additions to the Microsoft keyboard conventions in the 
VERITAS implementation of mnemonics and accelerators: 

VEA/Applications Help Additions to Microsoft Keyboard Conventions 

Convention Mnemonic Accelerator 

Find in Topic… F Ctrl + F 

Find Next N F3 

Find Previous P None 

Hide Navigation Tabs H None 

Index I None 

Print P None 

Search S None 

Synchronize N None 

Dialog Boxes 
Dialog boxes often contain groups of controls necessary to set options or settings for 
programs. 

You can select or choose controls that have an underlined letter in their titles by typing 
ALT + the underlined letter at any time when the dialog box is active. TAB moves the 
keyboard focus between controls, but which controls are included in the focus sequence, 
and the order of the sequence, may vary between applications. Typically, items that 
cannot be changed are not visited by the TAB key. Arrow keys are used to move within a 
list box, groups of option controls, or groups of page tabs. Arrow keys can move the 
keyboard focus between other controls but this behavior is not reliable. Options that are 
unavailable appear dimmed and cannot be selected. 

While the controls described here are typically found on dialog boxes, they also can occur 
in other contexts. 

Command buttons The OK button carries out the command using the information 
supplied in the dialog box. Other command buttons let you cancel the command or 
choose from additional options. 

Command buttons marked with an ellipsis (...) open another dialog box so you can 
provide more information or confirm an action. 
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Dialog Boxes 
A dark border initially indicates the default button. Press ENTER at any time to choose the 
button with a dark border. Use TAB to move the keyboard focus to the next control, and 
add SHIFT to reverse the direction. When you move the keyboard focus to a command 
button it temporarily takes the dark border, but when the keyboard focus is not on a 
command button the dark border returns to the default button. Press SPACEBAR to choose 
the command button you selected with TAB. Use ESC to immediately choose the Cancel 
button if there is one. Typing the access key for a command button will immediately carry 
out the command. 

Check boxes Use TAB to move between boxes and SPACE to change the check box to the 
next state. Typing the access key for a check box also will move the focus to the box and 
change is state. 

Option controls (also known as radio buttons) are used to select only one option from a 
group of options. (Like check boxes, option buttons may represent two or three states.) In 
some applications, you can add CTRL to move to the button without selecting it, then use 
SPACEBAR TO CHOOSE the currently selected option button. Typing the access key for an 
option control will also move the focus to the control and select it. 

Tabbed pages are used to fit many options into a single dialog box. They appear visually 
similar to dividers from a notebook. Each page contains separate groups of controls such 
as check boxes or option controls. Use TAB to move the focus to the tab for the currently 
visible page. Typing the access key for a page tab also will move the focus to the tab and 
display its page. 

The table, “Tabbed Pages,”  summarizes the actions for the keys in tabbed pages: 

Tabbed Pages 

Keys: Action: 

CTRL+PAGE DOWN OR CTRL+TAB


CTRL+PAGE UP


DOWN ARROW or UP ARROW


right arrow or left arrow 

Switches to the next tab and displays the page. 

Switches to the previous tab and displays the page. 

Chooses the tab in the next or previous row and displays the 
page. 

When the focus is on a tab selector, chooses the next or 
previous tab in the current row and displays the page. 

Sliders appear as an indicator on a vertical or horizontal gauge. The slider both displays 
and sets a value from a continuous range, such as speed, brightness, or volume. Use TAB 

or the appropriate access key to move the focus to the slider. 

Spin boxes appear as a text box with up and down arrows used to select from a list of 
fixed values. Use TAB to move the keyboard focus to the text box, then enter a valid value 
in the box or use the UP ARROW or DOWN ARROW keys to select the next higher or lower 
values. 
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Dialog Boxes 
List boxes display a column of available choices. If there are more choices than can fit in 
the open list box, moving the selection through the list will scroll more choices into view. 
Use TAB or type the appropriate access key to move the focus to the list box. 

Single selection list boxes allow only one item to be selected from the list at a time. Use 
the UP ARROW or DOWN ARROW keys to select items. Moving to a second item will 
automatically deselect all other items. 

Drop-down list boxes by default show only the selected item. There is a small button to 
the right of the control that shows a downward-pointing arrow. You can click the arrow to 
display more items from the list. You also can show or hide the list using ALT+DOWN 

ARROW, ALT+UP ARROW, or F4. In all other respects it behaves like a normal single-selection 
list box. 

Extended selection list boxes support selecting single items, blocks of items, or 
combinations of the two. After selecting an item as in a single-selection list box, hold 
down SHIFT+Navigation keys to select or deselect more items. 

Multiple selection list boxes typically have comparatively long lists and more of these 
items are expected to be chosen individually (not in blocks). Navigating to items does not 
automatically select them nor does selecting an item change the status of other selections. 
Press SPACEBAR to select or deselect an item. 

Combo-boxes and drop-down combo boxes are list boxes with attached edit boxes. You 
can make your selection by either typing in the edit box or using the standard commands 
to select from the list. 

The table, “Combo Boxes and Drop-Down Combo Boxes,”  summarizes the actions for 
keys in combo boxes: 

Combo Boxes and Drop-Down Combo Boxes 

Keys: Action: 

UP ARROW or DOWN ARROW 

PAGE UP or PAGE DOWN 

Selects the previous or next item. In an extended selection list 
box, add SHIFT to select additional items and add CTRL to 
move to an item without selecting it. In a multiple selection 
list box, moves without changing the selection. 

Selects the item up or down one screen. In an extended 
selection list box, add SHIFT to select additional items and add 
CTRL to move to an item without selecting it. In a multiple 
selection list box, moves without changing the selection. 

Edit controls are rectangular boxes used for displaying or editing text. Use TAB or the 
appropriate access key to move the focus to the edit control and select the text. 
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Glossary

ASL 

Action menu 

A context-sensitive menu that changes its menu options to match the type of object that is 
selected. By default, the Action menu is greyed out. When an object is selected, the Action 
menu provides access to tasks appropriate for the selected object. 

alert 

An indication that an error or failure has occurred on an object on the system. When an 
object fails or experiences an error, an alert icon appears. 

alert icon 

An icon that indicates that an error or failure has occurred on an object on the system. 
Alert icons usually appear in the status area of the main window and on the group icon of 
the affected object. 

Alert Monitor 

A window that provides information about objects that have failed or experienced errors. 

Array Support Library 

See ASL. 

A dynamically loadable library to discover attributes of a disk array. 

browse dialog box 

A dialog box that is used to view and/or select existing objects on the system. Most 
browse dialog boxes consist of a tree and grid. 
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CFS 

DCO 

button 

A window control that the user clicks to initiate a task or display another object (such as a 
window or menu). 

capability 

You can create volumes having specific capabilities. A capability is a simple name used to 
indicate what the capability means. Storage is allocated according to your request. For 
example, you can ask for a volume to be Performant and Reliable. These are capabilities 
have parameters such as, number of striped columns or number of mirrors. 

Cluster file system. A VxFS file system mounted on a selected volume in cluster (shared) 
mode. 

check box 

A control button used to select optional settings. A check mark usually indicates that a 
check box is selected. 

children 

Objects that belong to an object group. 

cluster 

A set of host machines (nodes) that shares a set of disks. 

cluster file system 

See CFS. 

command log 

A log file that contains a history of VERITAS Volume Manager (VxVM) tasks performed in 
the current session and previous sessions. Each task is listed with the task originator, the 
start/finish times, the task status, and the low-level commands used to perform the task. 

DCO Data Change Object 

See DCO. 

A Volume Manager object that keeps the Persistent FastResync tracking information 
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DDI 

DDL 

DMP 

dock 

DDI properties are device driver properties primarily used in Solaris OS. 

Device Discovery Layer. A facility of VxVM for discovering disk attributes needed for 
VxVM DMP operation. 

Device Discovery Layer 

See DDL 

Dirty Region Logging 

See DRL. 

device name 

The physical disk device name (or disk access name). 

dialog box 

A window in which the user submits information to VxVM. Dialog boxes can contain 
selectable buttons and/or fields that accept information. 

disk group 

A set of disks that are under VxVM control and share a common configuration. A disk 
group configuration is a set of records containing detailed information on existing 
VERITAS Volume Manager objects (such as disk and volume attributes) and their 
relationships. Each disk group has an administrator-assigned name. Volumes can only be 
created on disks that belong to disk groups. 

disk name 

The VERITAS Volume Manager disk name (or disk media name). This is the logical name 
given to the disk by VxVM or the administrator. 

The VERITAS Volume Manager Dynamic Multipathing facility. 

To separate or attach the main window and a subwindow. 
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DRL 

gap 

grid 

GUI 

host 

A VxVM mechanism that tracks mirror write inconsistency which helps in fast 
resynchronization of mirrors after system crash. Even though the term log is used, 
internally DRL is implemented as a map. 

Dynamic Multipathing 

See DMP. 

enclosure 

A disk array. 

FastResync 

A VxVM feature for fast resynchronizing of stale mirrors at the time of reattach which 
were earlier split off as a result of snapshot or detach operation. 

A disk region that does not contain VERITAS Volume Manager objects (subdisks). 

graphical view 

A window that displays a graphical view of objects. In VxVM, the graphical views include 
the Object View window and the Volume Layout Details window. 

A tabular display of objects and their properties. The grid lists VERITAS Volume Manager 
objects, disks, controllers, or file systems. The grid displays objects that belong to the 
group icon that is currently selected in the object tree. The grid is dynamic and constantly 
updates its contents to reflect changes to objects. 

group icon 

The icon that represents a specific object group. 

Graphical User Interface. 

A machine or system. 

launch 

To start a task or open a window. 
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LUN 

node 

Logical Unit Number. Each disk in an array has a LUN. Disk partitions may also be 
assigned a LUN. 

main window 

The main VERITAS Volume Manager window. This window contains a tree and grid that 
display volumes, disks, and other objects on the system. The main window also has a 
menu bar, a toolbar, and an optional Command Launcher. 

menu 

A list of options or tasks. A menu item is selected by pointing to the item and clicking the 
mouse. 

menu bar 

A bar that contains a set of menus for the current window. The menu bar is typically 
placed across the top of a window. 

mirror 

A copy of a volume and its data. There can be several mirrors per volume. The terms 
mirror and plex are used synonymously. 

In the VxVM tree, a node is an element attached to the tree. 

In a cluster environment, a node is a host machine in a cluster. 

object group 

A group of objects of the same type. Each object group has a group icon and a group 
name. In VxVM, object groups include disk groups, disks, volumes, controllers, free disk 
pool disks, uninitialized disks, and file systems. 

object tree 

A dynamic hierarchical display of VERITAS Volume Manager objects and other objects on 
the system. Each node in the tree represents a group of objects of the same type. 

Object View Window 

A window that displays a graphical view of the volumes, disks, and other objects in a 
particular disk group. The objects displayed in this window are automatically updated 
when object properties change. This window can display detailed or basic information 
about volumes and disks. 
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plex 

Organization principle for disk group 

An organization principle is associated with a disk group. These disk groups have storage 
pools present on them. Volumes created on such disk groups are maintained by ISP. 
Traditional volumes cannot be created on these disk groups. You have the option of not 
associating a organization principle to a disk group. 

A copy of a volume and its data. There can be several plexes per volume. The terms mirror 
and plex are used synonymously. 

popup menu 

A context-sensitive menu that only appears when you click on a specific object or area. 

properties window 

A window that displays detailed information about a selected object. 

radio buttons 

A set of buttons used to select optional settings. Only one radio button in the set can be 
selected at any given time. These buttons toggle on or off. 

rules 

Rules specify the storage allocation criteria. These define storage selection and storage 
layout. Rules are simple sentences written in the ISP language. 

scroll bar 

A sliding control that is used to display different portions of the contents of a window. 

Search window 

The VERITAS Volume Manager search tool. The Search window provides a set of search 
options that can be used to search for objects on the system. 

splitter 

A bar that separates two panes of a window (such as the object tree and the grid). A 
splitter can be used to adjust the sizes of the panes. 

status area 

An area of the main window that displays an alert icon when an object fails or experiences 
some other error. 
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tree 

storage pool - data pool, clone pool 

Storage pools are associated with disk groups. Storage pools are defined by templates, 
capabilities and policies. Policies governing a storage pool decide 

◆ to grow a storage pool to accommodate additional storage 

◆ to use templates not currently associated with it. 

There are two types of storage pools: data pools and clone pools. Data pools are created 
first. All other storage pools that are created within a disk group are clone pools. 

subdisk 

A set of contiguous disk blocks that form a logical disk segment. Subdisks are associated 
with plexes (mirrors) to form volumes. 

task properties window 

A window that displays detailed information about a task listed in the Task Request 
Monitor window. 

task request monitor 

A window that displays a history of tasks performed in the current VERITAS Volume 
Manager session. Each task is listed with the task originator, the task status, and the start/ 
finish times for the task. 

toolbar 

A set of buttons used to access VERITAS Volume Manager windows. These include 
another main window, a task request monitor, an alert monitor, a search window, and a 
customize window. 

A dynamic hierarchical display of objects on the system. Each node in the tree represents 
a group of objects of the same type. 

uninitialized disks 

Disks that are not under VxVM control. 

user templates 

User templates are a collection of capabilities, templates and rules defined by the user to 
simplify tasks. You can group the capabilities you want the volume to have, and save 
these capabilities along with the rules as a user template. 
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VxFS 

VxVM 

volume 

A virtual disk or entity that is made up of portions of one or more physical disks. 

Volume Layout Details Window 

A window that displays a graphical view of a volume and its components. The objects 
displayed in this window are not automatically updated when the volume properties 
change. 

Volume to Disk Mapping Window 

A window that displays a tabular view of volumes and their underlying disks. This 
window can also display details such as the subdisks and gaps on each disk. 

volume set 

The volume set feature provides support for the multi-device file system enhancement of 
VERITAS File System (VxFS). A volume set allows several volumes to be treated as a 
single object with one logical I/O interface. 

VERITAS File System. 

VERITAS Volume Manager. 
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selecting 13 
sorting 13 
viewing 12 

Options menu 4

overwriting the event log file 29

overwriting the task log file 31


popup menus 18
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PropertySet 17 

Reconnect at Logon 24 
remote administration 1 
Remove From Favorites 25 
running tasks 17 

security 2, 10 
Selected menu 17 
selecting objects 5, 13 
selections 

multiple 5 
server 9 
setting up your system 9 
Silent Logon 23 
sorting objects 13 
splitter 4 
starting VEA 10 

status area 5 
status view 16 
system 

setup 9 

task log 30 
task log file 

overwriting 31 
tasks 

accessing 17 
displaying 6 
from menus 17, 18 
properties 7 
request monitor window 6 
running 17 
throttling 7 
viewing 6 

tear off 5

Technical assistance xi

Toolbar 5

tree


object 3 

user profiles 32 

VEA 
accessibility 37 
starting 10 

VEA Console 1 
description 1 

viewing commands 6 
viewing objects 

and object properties 12 
viewing tasks 6 
views 

printing 32 

window menu 4 
windows 

main window 2 
resizing 4 
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